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Introduction 
FireStore FS-4 and FS-4Pro1 are the first portable DV disk recorders 
with Direct To Edit (DTE) technology designed for hand held cam-
corders in a small, rugged and shock proof chassis.

If you edit with applications from Adobe, Apple, Avid, Canopus, 
Matrox, Pinnacle, Sonic Foundry, Ulead, and many others, Fire-
Store's DTE Technology is the only solution that can save you up to 
25 hours a month by recording clips to disk in your NLE’s native file 
format.

What is DTE Technology? 
A DTE Disk recorder is a stand-alone device that records DV25 video 
to a disk drive in NLE native file formats. When the disk drive is con-
nected to a computer, clips are immediately available for editing. This 
eliminates the need to capture, transfer or convert the clips prior to 
editing.

Features 
The FS-4 and FS-4Pro offer the following:

• Tapeless acquisition - Record directly from your camcorder 
while you shoot using Direct To Edit (DTE) Technology. When you 
are finished shooting, connect the FS-4 to your computer and you 
are instantly ready to edit in the timeline.

• True DTE Technology - Files are recorded to disk as RawDV, 
AVI Type 1, AVI Type 2, 24P AVI Type 2, Matrox AVI, Canopus 
AVI, QuickTime or QuickTime 24P. 

• Fast and Efficient Editing - Once you have finished shooting, 
you can mount the FS-4 to your Mac or PC editing system like a 
normal FireWire hard disk drive. Transfer clips to your NLE's 
media drive at up to 400 Mbps or edit instantly in real-time using 
the FS-4 as your media source.

• Confidence in Recording - Simultaneously record to disk and 
tape while you shoot, providing an immediately available, drop 
out free, edit source and an archive and backup on tape.

• Compact, Lightweight, Rugged Design - The FireStore FS-4 
weighs less than one pound including the battery and is only 1.5" 
thick. You can mount the FS-4 directly to your camcorder using 

1. In this manual, when the FS-4 is indicated, it means FS-4 and 
FS-4Pro unless specifically indicated.
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the optional camera mount kit, or clip the FS-4 directly to your 
belt. The FS-4 can withstand the rigors of field shooting. The six 
second electronic shock cache ensures your video is always 
recorded even in the roughest of conditions.

• Flexible Capacities and Power - The FS-4 comes with a 40GB 
(about 3 hours) hard drive. Extend record times by linking two 
FS-4 units together. Power the FS-4 using slim, removable bat-
tery packs or power it using the supplied AC adapter.

• Easy to Use, Control and Update - The FS-4 interfaces with 
your camcorder using a single FireWire cable that passes audio, 
video, timecode and control information. When a tape is present, 
each press of start and stop on your camcorder's record button 
creates an individual clip on disk. The FS-4 features a compre-
hensive backlit display, menu system and buttons allowing easy 
control and management. These units are upgradeable in the 
field.

• Never Miss A Shot - FireStore FS-4's six second retro record 
mode means you are always recording. When action happens, 
you know up to six seconds prior to the event occurring is saved 
in your clip.

The FS-4Pro also provides the following:

• Retro Disk and Loop Record modes.
• Scene Marking which allows clips to be categorized into pre-

named folders on disk while you shoot.
• User definable 10-second retro record feature.
• User definable time lapse and loop playback modes. 
• Pinnacle AVI and Avid DV-OMF support.
• Available with either 40GB or 80GB (about 6 hour) capacities. 
• Free Run and Regen timecode modes.

Unpacking 
Before using the FS-4, open the package and make sure you have all 
of the following items:

• FS-4 unit
• Power supply with cable and connector to the FS-4
• Removable power supply cable for wall outlet to power supply 

(International only)
• Belt Clip
• Four foot long, 6-pin to 4-pin Firewire Cable
• User Guide
• Removable Li-Ion Battery Pack
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Quickstart 
This section contains information to help you to use the FS-4 as 
quickly as possible. It contains the following sections:

• Physical Description and Basic Controls
• The FS-4 Menu System
• Installing and Removing the Battery Pack
• Connect the FS-4 to AC Power
• Connect the FS-4 to a DV Camcorder
• Recording and Playback with the FS-4
• Power “On” the FS-4
• Set the Time and Date
• Select a DV File Format
• Recording With FS-4
• Manual Recording
• Syncro Slave Recording
• Playback on the FS-4
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Physical Description and Basic Controls
Front Panel Controls

The front panel of the FS-4 is illustrated below.

Screen

This is a 14 character by 7 line dot matrix, backlit, LCD display.

Function Keys

Function A (left), Function B (Center), Function C (Right)

The three keys below the FS-4 LCD display are user-defined function 
keys for selecting items on the bottom-most LCD line. The function of 
these soft keys changes depending upon what is displayed on the 
screen above the particular key. Refer to the “Functions Screen” on 
page 42 for more information.

Power On Key

To power on or reset the FS-4 after it is powered on, hold down this 
key for two seconds.

Screen

Function
Keys

Power On
Record
Button

Speaker

Navigation
Keys

Transport
Control
Keys
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To power off the FS-4, hold down the stop key (n) for three seconds. 
During power off, the FS-4 makes an audible beep indicating it is turn-
ing off.

Navigation Keys

These keys enable you to navigate the FS-4 menu. The navigation 
keys include Left, Right, Up, Down, and Select. Left, Right, Up, and 
Down keys repeat.

Transport Control Keys

Use these keys to control FS-4 playback and record functions. You 
usually operate these transport keys while on the HOME Screen.

Top Row:

Record Key  

Press this key once when the FS-4 is in STOP mode to put the FS-4 
into REC-PAUSE. Press it again to start recording. If you press the 
REC button during a recording, the current clip is closed and a new 
clip is created without dropping any frames. This key is the only key 
that has a red legend on the front panel. 

Middle Row:

Back Search Key  WW

Press this key to play video at speeds different than real-time. Refer 
to the NOTE below.

Play Key  X

Press this key to start playback of the selected clip. 

Forward Search Key  XX

Press this button to play video at speeds different than real-time. 

NOTE: Pressing the Fast Forward (FF) Search key multiple times 
results in increases in the search speed. This mode is bidirectional. 
For instance, if you are in 10X FF speed and you press the Back 
Search key once, the FS-4 is now in 2X FF mode. This applies as 
well for backward search speeds. The default speed resolution is as 
follows (NTSC, PAL have slightly different multiples for < 1X):

• Reverse: -30X, -10X, -2X, -1X (reverse play), -1/2X(-15fps), Still. 
• Forward: Still, +1/2X (+15fps), +1X (play), +2X, +10X, +30X
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Bottom Row

Back Index Key  |WW

This key returns the FS-4 to the beginning of the current clip when in 
playback mode. Press this button twice in sequence to return the FS-
4 to the previous clip during playback. In STOP mode, press this key 
to return the FS-4 to the beginning of the previous clip. 

Stop Key  

While in the Home Screen, and in any transport mode, press this key 
to Pause the FS-4. Press it again to stop the FS-4. Refer to the sec-
tion, “Setup Screen” on page 37 for more information.

NOTE: To power off the FS-4, hold down the stop key (n) for three 
seconds. During power off, the FS-4 makes an audible beep indicat-
ing it is turning off.

Forward Index Key  XX|

Use this key to skip forward to the next clip in STOP and PLAY 
modes.

Internal Speaker

The Internal speaker is used for alarms and audible feedback. You 
can disable audible feedback in the Settings menu if desired. The 
power, temperature, and disk capacity alarms are always active.
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Top Panel

The top panel contains the following connectors and LEDs:

States of Charge LED

• Off No Charger Connected
• Green Fast Charge Mode
• Yellow Float Charge Mode
• Red Charger Error
• Red/Yellow No battery installed / battery error
• Yellow Blink Charger voltage insufficient

States of Status LED

• Off Power Off Mode
• Green Power On Mode - On, but no activity.
• Yellow Playback (Blinks when the Hard drive is being 

accessed.
• Red Record Mode
• Blinking Red Record Pause

Computer FireWire Connector

• In/Out: 6-pin IEEE-1394a port x 1
• Asynchronous Data I/O 

Charge LED
Status LED

Camera
Firewire
Connector

Serial
Connector

Computer
Firewire Connector

(remote 
 control)
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Serial Connector

GPI / RS232C; 3.5mm TRS mini jack. (3.5mm to DB-9 cable acces-
sory available). Switchable to act as a simple contact closure or RS-
232C port. You can also connect an optional wired remote com-
mander.

Camera FireWire Connector

• DV Video I/O 
• 6-pin IEEE-1394a connector
• Isochronous 25Mb/s DV video I/O
• Embedded 2-ch (48kHz, 16-bit) or 4-ch (12-bit, 32kHz) audio

Rear Panel 

The rear panel contains the following important items:

Belt Clip
Post

Fan Intake
Vent

Battery
Compartment
Latch

Battery
Compartment

(Do Not
Block!)



9

Side Panel 

The side panel contains cooling vents as illustrated below.

Bottom Panel 

The FS-4 bottom panel features a single 2-pin DC power connector. 
Connect the supplied AC power adapter here.

Cooling Vents
(Do Not Block!)

Cooling Vents
(Do Not Block!)
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The FS-4 Menu System 
The FS-4 menu system provides an easy way to perform the func-
tions available in the unit. Each of the screens below (except the Wel-
come Screen and the Home Screen which come up automatically 
when you start the unit) can be accessed by repeatedly pressing the 
Left or Right navigation keys. The functions of each of the selections 
on these screens is explained in more detail in “FireStore Functions” 
on page 28.

NOTE: To get to the top of any menu, press the Left key. To get back 
to the Home Screen, press the Select Key.

Welcome Screen - only appears for several seconds upon power up.

Home Screen - starting screen for all functions. Displays disk and 
operational status.

Control Screen - contains the following selections: Local, Tapeless, 
AV/C, Synchro Slave

Play Screen - contains the following selections: Play Clip, Loop Clip, 
Loop All, Play All

Utilities Screen - contains the following selections: Delete Clip, For-
mat, Repair Disk, Repair Clip, File Name, and Upgrade. The FS-4Pro 
provides the following additional functions: Organize Reel, Organize 
OMF, and Organize Pinnacle

Functions Screen - contains user definable function key selections. 
Changing a setting with a Function key is identical to changing the 
setting in its corresponding menu. Refer to “Functions Screen” on 
page 42 for more information.

Setup Screen - contains the selections for the FS-4 LCD, Alarm, 
Stop Output, GPI Control Options, Timecode, and LCD Control Set-
tings.

DV Formats Screen - contains the following selections: Raw DV, AVI 
Type 1, AVI Type 2, Canopus AVI, Matrox AVI, Quicktime, Quicktime 
24P, 24P AVI Type 2. The FS-4Pro provides Pinnacle AVI and Avid 
OMF.

HDD Mode Screen - contains the following selections: DV Recorder, 
DD Drive, and Use Ext. FS-4.

Record Screen - contains the following selections: Normal Record 
and Retro Cache Record. The FS-4Pro also contains Retro Disk 
Record and Loop Record.
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Reels Screen (FS-4Pro only) - allows selected clips to be marked for 
placement in particular Reels Folders. 

Installing and Removing the Battery Pack
Before operating the FS-4, install the battery as follows: 

Step 1: Turn the FS-4 unit over, so that the back is facing you as
shown in the following illustration.

Step 2: Slide the battery pack into the compartment. Make sure
the contacts on the side meet the contacts on the inside
of the unit.

Step 3: Make sure the battery latch clicks into place.
You can immediately use the FS-4 unit if you attach the AC power 
cord with or without the battery pack installed. 

You must charge the battery until the battery status LED indicates the 
unit is charged before you can use the FS-4 with the battery. The 
Charge LED on the top of the FS-4 lights to show the battery is charg-
ing. A flat battery on charge will take 2-3 hours to charge with the unit 
powered off.

The included battery will supply power to the FS-4 for about 90 min-
utes while in continuous Record or Playback mode.

Battery Latch

Battery
Compartment
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To remove the battery, use the following steps:

Step 1: Slide the battery latch to the left and slide downward on
the battery pack about 1cm or 3/8.

Step 2: Remove the battery pack.

Connect the FS-4 to AC Power 
You can use the FS-4 immediately after you install the battery using 
AC power. 

NOTE: You can use the FS-4 without a battery installed.

To do this, connect the AC power as follows:

Step 1: Plug the cord from the power supply into the bottom of the
FS-4.

Step 2: Connect the line cord to the rectangular power supply
(International models only).

Step 3: Plug the line cord or AC adapter into an electric outlet.

Connect the FS-4 to a DV Camcorder 
Before performing this procedure, make sure you have performed 
“Installing and Removing the Battery Pack” on page 11 and/or “Con-
nect the FS-4 to AC Power” on page 12.

Step 1: Connect the supplied Firewire cable to the “DV I/O”
connector on the top of the FS-4. (Only one end will match
the plug in the FS-4.)

Step 2: Locate the FireWire/DV/iLink (or similar) connector on
your video camera. It is located in different places
depending upon the brand of camera. If you are unclear
of its location, consult your video camera manual.

Step 3: Connect the other end of the FireWire cable to your video
camera.

Step 4: Turn on the video camera.
Step 5: Turn on the FS-4.
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Recording and Playback with the FS-4 
Before using the FS-4, you must prepare it by performing the follow-
ing procedures:

• Power “On” the FS-4
• Set the Time and Date
• Select a DV File Format
• Recording With FS-4
• Manual Recording
• Syncro Slave Recording
• Playback on the FS-4

The values you select with these procedures will remain the same 
during power cycles and will not change unless you specifically 
change them.

Power “On” the FS-4
Step 1: Press the power button for two seconds and release it.

Power Button Navigation
Buttons

Function 
Buttons
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Step 2: Wait for the following Welcome screen to appear.

This Welcome screen appears as the unit initializes. You are ready to 
proceed when the Home screen (shown below) appears.

Set the Time and Date
After you have powered on the FS-4, set the time and date as follows:

Step 1: Press the Right navigation key several times until the
Setup Screen appears on the screen as shown below:

Step 2: Use the Down navigation key to highlight the date and
press the Right navigation key to highlight the date. The
highlighted item is the one currently selected. The
following screen appears:
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Step 3: Use the Up and Down navigation keys to change the
highlighted value. Use the Right and Left navigation keys
to highlight the Month, Day, and Year.

Step 4: When complete, press the right-most Function Key
indicated as BACK on the screen. The new date will be
indicated on the Setup Screen.

Step 5: Use the Down navigation key to select the time and press
the Right navigation key. The following screen appears:

Step 6: Use the Up and Down navigation keys to change the
highlighted value. Use the Right and Left navigation keys
to highlight the Hour, Minute, and Second. (Time is
indicated in 24hr. mode.)

Step 7: Press the right-most Function Key indicated as BACK on
the screen. The new date will be indicated on the Setup
Screen.
The Time and Date are now set.

Step 8: Press the Left Navigation key to return to the beginning
screen.

For more information on the Setup function, refer to the section, “Setup
Screen” on page 37.
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Select a DV File Format 
After setting the time and date, but before recording, you should set 
the DV file format as follows:

Step 1: Press the Right navigation key several times until the DV
Formats Screen appears on the screen as shown below:

For a complete and up-to-date list of supported applica-
tions and their associated formats, visit the website: 
http://www.firestore.com

Step 2: Use the Up and Down navigation keys to select the
required DV file format that supports your NLE system.
The dash on the left side of the selection indicates the
current selection. The default value is AVI Type 2.

Step 3: Press the center Select button on the navigation keys.
NOTE: 24p modes are only for use with camcorder's that are capable 
of DV-24p Advanced mode.

Recording With FS-4 
Recording with the FS-4 consists of the following activities:

•         Manual Recording 
•         Syncro Slave Recording or Tapeless Recording

In all cases, make sure that you have set the time and date, set the 
recording format as explained above and connected the FS-4 to your 
video camera as explained in “Connect the FS-4 to a DV Camcorder” 
on page 12.
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Manual Recording 
Before recording, make sure both the video camera and the FS-4 are 
powered on and connected with the FireWire cable.

Step 1: Set your video camera to “Camera” or “Cam” mode. Make
sure you can see an image through the viewfinder.

Step 2: On the FS-4, press the Record key. This sets the FS-4 to
RECORD-PAUSE mode.

Step 3: On the FS-4, press the Record key a second time. The
FS-4 begins to record. The timecode value is displayed on
the screen.

Step 4: Press the Stop key to put the FS-4 into RECORD-PAUSE
mode.

Step 5: Press the Record key, the FS-4 begins to record again on
the same clip.

Step 6: Press the Stop key twice to stop the recording. 
Step 7: Press the Record key again to begin recording a new clip.
When in Record mode if you want to break the recording into a new, 
separate file without dropping frames, press Record and a new clip is 
automatically created.

CAUTION: Never disconnect the power or the FireWire cable during 
a recording. This will cause file corruption.

Record Key

Stop Key
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Syncro Slave Recording 
Synchro slave recording allows you to control FS-4 operation com-
pletely from the video camera. 

Make sure the FS-4 is in STOP mode and that the video camera and 
the FS-4 are connected. Also make sure that a video tape is in the 
camera unless your camera supports tapeless recording. If it does 
support tapeless recording, refer to the section, “Setup Screen” on 
page 37.

Step 1: From the FS-4 Home screen, press the Right navigation
key several times until the Control Screen appears on the
screen as shown below:

Step 2: Use the Down navigation key to select Synchro Slave.
The dash on the left side of the selection indicates the
current selection. The default value is Local.

Step 3: Press the center Select button on the navigation keys.
The beginning screen returns and a Pause indicator appears in the 
upper left-hand corner of the FS-4 screen. Next to this symbol, is a 
“Y” indicating that control for both units is from the video camera.

Step 4: You can now use the video camera record controls and
the FS-4 will respond to these controls. The recording
signal goes both to the tape in the camera and to the FS-
4.
NOTE: By selecting EXT TC in the Setup menu, you can 
record the camcorder’s Timecode in the file.

NOTE: You can also perform these tasks using customized function 
keys. For information on setting up function keys, refer to the section, 
“Functions Screen” on page 42
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Playback on the FS-4 
Before playing back a recording, you must have first recorded some-
thing. Also, make sure both the video camera and the FS-4 are pow-
ered on and connected together with the FireWire cable.

NOTE: This feature may not be available on PAL cameras.

Step 1: Set your video camera to “VCR” or “playback” mode. 
Step 1: Navigate to the clip you want to preview by using the

bottom Left and Right transport control keys.

Step 2: On the FS-4, press the Play key. 
Step 3: Press the Fast Forward or Fast Backward key as

required. Refer to “Quickstart” on page 3 for more
information on the function of these keys.

Using the FS-4 with a Computer 
Once you have recorded FS-4 clips to a FireWire disk drive using 
FireStore, you can use those clips in most computer based DV NLE 
systems. 

Traditionally, in order to get footage into an NLE system, it was neces-
sary to capture or digitize that footage utilizing a video capture card. 
Using the FS-4 recorded clips, you can skip this capture stage by just 
connecting the FS-4 to your computer with an OHCI compliant IEEE-

Transport Control
Keys

Play Key
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1394 (FireWire) port using the HDD Bypass mode (refer to page 2-15 
for more information).

The FS-4 can be connected to any computer system that will read a 
FAT 32 volume. This includes Windows 98SE/ME/2000/XP and Mac 
OS9/OS10. FAT32 volumes will not work with Windows NT. 

Check the FOCUS Enhancements' website (www.FOCUSinfo.com) 
for more compatibility information.

In order to use the FS-4 with a computer, you must have an active 
IEEE-1394 connection on your computer. You also must have loaded 
any required FireWire disk drive drivers onto your computer system.

Use the MODE screen to go into HDD mode. This step is required 
before mounting the FS-4 to your computer. Refer to the section, 
“HDD Mode Screen” on page 34 

Connect the FS-4 to your computer system utilizing a standard 6-pin 
to 6-pin FireWire cable and connect power to the drive if necessary 
(some FireWire disk drives receive power from the computer's 
FireWire connection). 

Consult your FireWire disk drive documentation for more information.

This section contains the following subsections:

• Mounting the FS-4 (Windows)
• Using Avid OMF Clips (FS-4Pro only)
• Dismounting the FS-4 (Windows)
• Mounting the FS-4 (Macintosh)
• Dismounting the FS-4 (Macintosh)
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Mounting the FS-4 (Windows)
Use this procedure for Windows XP, 2000, 98SE and ME.

Step 1: On a Windows-based computer system, double click the
My Computer icon on the top left hand corner of the
desktop. You will see a window similar to the following:

Step 2: Locate the FS-4. It appears as a standard FireWire disk
drive. It will probably be labeled E:, F:, G:, and so on.
(drive C: is usually your computer's main disk drive). Once
you have identified it, double click on the FS-4. 

Step 3: Once you have located your FS-4, double click the disk
icon to open it up. Once opened, open the folder with the
most recent date code (for example, “20050127-110345-
01”) and you will see a window similar to the following:

NOTE: On the FS-4Pro, if you have assigned clips to a Reel folder, 
open that particular folder to locate your clips.
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The FireWire disk drive contains several different files. Clips can 
appear as: 

• RawDV (.dv)

• AVI Type 1 - (YYYYMMDDHHMMSSa01)

• AVI Type 2 or 24p AVI Type 2 - 
(YYYYMMDDHHMMSSb01)

• Canopus AVI - (YYYYMMDD-HHMMSSb01)

• Matrox AVI - (YYYYMMDD-HHMMSSm01 with a sepa-
rate .wav audio file per track)

• FS-4Pro only. Pinnacle AVI - (YYYYMMDD-
HHMMSSp01 with two separate .wav audio files per 
track)

• QuickTime or 24p Quicktime (.mov)

• FS-4Pro only. Avid OMF (.omf with two separate .aif 
audio files per track).

The FAT32 file system is limited to a 2GB file size. This equates to 
roughly 9 minutes of recording time.

When clips are being recorded to the FS-4 that exceed 9 minutes in 
length, the FS-4 automatically creates a new file without dropping any 
frames. 

The two clips have the same primary file name, however, the last two 
digits are different. 

The first 2GB part of the clip is labeled with “-01” after the primary file 
name. 

The second 2GB segment is labeled with a “-02”. Additional 2GB seg-
ments are labeled with a “-0X” number.

With most NLE systems on a Windows computer, you can use clips 
within the timeline by selecting the clips on the source volume (the 
connected FS-4) and importing them directly into the NLE’s bin. 

Clips can then be immediately used in the NLE’s timeline. 

With FS-4, the drive itself is fast enough to directly stream the clips to 
the NLE, eliminating the need to copy or transfer the clips before use.

When utilizing the Avid OMF file format, you must use the steps in the 
following section to import clips.
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Using Avid OMF Clips (FS-4Pro only) 
The Avid DV OMF file format was developed for use with Avid editing 
products on Windows 2000, Windows XP or Mac 0SX. These prod-
ucts include Avid Xpress Pro, NewsCutter, and Media Composer 
Adrenaline (with the DV option).

The Avid DV OMF file format creates three files simultaneously; an 
OMF video file and two separate AIF audio files. On the computer's 
desktop, the files appear similar to the one shown below.

On the FS-4, the video file (OMF) and the audio files (AIF) appear as 
one track. 

If you delete an Avid DV OMF file, the FS-4 deletes the audio and 
video portions at the same time.

In order to use the FS-4 recorded Avid DV OMF files on your Avid 
NLE system, use the following procedure.

Step 1: Locate the FS-4 on your computer. 
Step 2: Open the FS-4 drive when you have found it, and create

a new folder named “OMFI MediaFiles”. 
To do this on Windows, select File>New>Folder from the 
pull down menu. 
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On the Macintosh, select File>New Folder. You must 
type “OMFI MediaFiles” correctly in order for Avid to see 
the disk drive. 

Step 3: Drag all the OMF and AIF files into the new folder (do not
drag in the files titled Desktop DB or Desktop DF). 
NOTE: if you are using the ORGANIZE OMF function on 
the FS-4 prior to using the disk on a computer, step 2 and 
3 are not necessary.

Step 4: Launch Avid. 
Step 5: Once you have opened the desired project or created a

new project, select Tools>MediaTool. A screen similar to
the following appears:

Step 6: Locate and select the FS-4 under Media Drive(s). 
NOTE: If the drive does not appear, check to make sure 
you have created the OMFI MediaFiles folder correctly 
with proper case and spacing. Also, check to see that the 
drive is properly connected and recognized by the com-
puter). Under Project(s), select All Projects (This high-
lights all items in the Project(s) window). 
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Step 7: Make sure Master Clips is checked and press OK. The
Media Tools Window similar to the following appears:

Step 8: Create a new bin (select File -> New Bin) or open an
existing bin in Avid. 

Step 9: Once opened, select all items in the Media Tools window
(select Edit> Select All). 

Step 10: Drag the contents of the Media Tools Window into the bin.
It is now possible to use these clips in the Avid timeline.

Dismounting the FS-4 (Windows)
Once you have completed working with the FS-4 on a Windows XP, 
Windows 2000, Windows 98SE or Windows ME computer system, 
you must dismount the drive before unplugging it. 

To do this, use the following procedure: 

Step 1: Click the Stop Device icon at the bottom right side of the
Windows task bar as shown below.

Step 2: Once clicked, your computer system prompts you to
“STOP” the connected FS-4. This begins the dismount
process. 

Step 3: Select the message by clicking on it. The computer will
now dismount the FS-4 and notify you when it is safe to
remove the volume.
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Mounting the FS-4 (Macintosh)
Step 1: On a Macintosh, start your computer and connect your

FS-4 to the computer utilizing a standard 6-pin to 6-pin
FireWire cable. 
When mounted, your FS-4 should appear on the com-
puter's desktop as shown below:

The FS-4 appears as a FAT32 volume with a PC label. 
This is not always the case on Mac OSX however.

Step 2: Once you have located your FS-4 on the desktop, double
click the disk icon to open it up. Once opened, open the
folder with the most recent date code (for example,
“20050127-110345-01”) and you will see a window similar
to the following:

NOTE: On the FS-4Pro, if you have assigned clips to a Reel folder, 
open that particular folder to locate your clips).
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Dismounting the FS-4 (Macintosh)
Once you have completed working with your FS-4 on a Macintosh 
computer system, you must dismount the drive before unplugging it. 

Do this as follows:

Step 1: Select the FS-4 on the computer's desktop. It is marked
with a PC symbol. 

Step 2: Drag the drive into the trash or use the eject button. This
dismounts the particular disk drive.

Transferring Clips to Your NLE System
To perform this task, find the FS-4 drive on your computer desk top 
and copy the clips into the selected folder on your computer.

Charging the Battery 
The battery begins charging anytime it is connected to AC power 
using the AC adapter supplied with the FS-4. The charge LED lights 
when the FS-4 is charging. For information on the charge LED, refer 
to the subsection “Top Panel” on page 7

NOTE: The FS-4 can be charged through the FireWire port under 
some circumstances.

Battery Use Warnings
Batteries can cause property damage and/or bodily injury such as 
burns if a conductive material such as jewelry, keys, or beaded chains 
touch exposed terminals. The conductive material may complete an 
electrical circuit (short circuit) and become quite hot. Exercise care in 
handling a charged battery, particularly when placing it inside a 
pocket, purse, or other container with metal objects. 

NOTE: Use only FOCUS Enhancements original battery chargers.

Mounting to a Camcorder
Mount the FS-4 to your camcorder using the optional Camcorder 
Mount Kit (P/N ASYF-0849-01). Contact FOCUS Enhancements for 
more information and to order this kit.
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Belt Mounting 
A belt mount clip is included with the FS-4. This mount is similar to 
those used with cellular telephones. Attach the belt mount to the belt 
clip post on the rear of the FS-4 and push it down to lock it in position. 
The belt clip can ratchet to various positions when attached to a belt.

FireStore Functions 
FS-4 screens are organized in a flat hierarchy. Every screen has a 
unique name, and you can cycle continuously through the screens 
using the Left and Right Navigation Keys. 

Use the Up and Down Navigation Keys to cycle through screen 
selections.

Use the Select Navigation Key to make a choice. 

NOTE: When you navigate through the LCD Screens and scroll down 
into the menu, you can press the Left navigation key on the front 
panel and immediately return to the top of the Screen so you can nav-
igate to the other screens. To return immediately to the Home Screen, 
press the Select key.

This section contains information on the following screens:

• “General Screen Information” on page 29
• “Record Screen” on page 31
• “HDD Mode Screen” on page 34
• “DV Format Screen” on page 36
• “Setup Screen” on page 37
• “Functions Screen” on page 42
• “Utilities Screen” on page 45
• “Control Screen” on page 53



29

General Screen Information
Use the following information to get acquainted with the screens and 
their displays.

Welcome Screen

The Welcome Screen appears briefly after boot-up, and automatically 
switches to the Home Screen when the FS-4 is ready for operation.

Screen Name:
When the Cursor is 
on the title (screen
name), the title 
appears in inversed
text. Press the Left 
or Right Navigation 
Key to move to the 
previous or next
screen. Use the 
Select key to jump
to the HOME screen.

Screen Values:
When the Cursor row is on a value, the option is inversed.
Use the Up or Down Navigation key to cycle through the 
values, including the screen name. Values may be one time 
selectable, selectable among groups, or navigable to another 
screen as indicated by “>”.
 
The FS-4 screens are organized by function. Each screen 
contains a list of options. An option can be:
 - A setting that is inclusive of other options currently 
shown (like a check box)
 - A setting that is exclusive of other options that are grouped 
with it (like a radio button)
 - A link to a secondary function screen 
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Home Screen

The HOME screen is read only and cannot be navigated. The only 
way off the HOME screen is by using the Left or Right Navigation 
Key. 

1 - Current function (Symbol and Descriptions) - Refer to “Physical 
Description and Basic Controls” on page 4.

2 - Volume Disk number. Volume number is always “1” unless multiple 
FS-4’s are connected.

3 - Clip Number, for example, 001 (Clip 1).

4 - Timecode Value - 00:00:00:00 (Drop Frame), or 00;00;00;00 (Non 
Drop Frame)

5 -Time remaining on the disk. 

6 - FS-4Pro Only: Reel Display - In RECORD or PLAYBACK modes, 
this selection displays the particular REEL a clip is in or has been 
marked to, If in PLAY FROM -> REAL LIST mode, REEL appears in 
brackets for example, “<REEL>”. If no REEL has yet been selected, 
this area is blank.

7 - Battery life gauge.

Information Screens

An information screen is generated automatically by an event as 
shown in the following example screen. 

Press BACK to clear the screen and return to the last screen.

 
1

2

3

4

5
6

7
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FS-4 information screens indicate conditions such as high tempera-
ture, power remaining, or drive capacity remaining. 

Record Screen
On the FS-4, the only two choices in the RECORD MENU are NOR-
MAL and RETRO CACHE. It is not possible to set a RETRO CACHE 
time value, by default, set at 6 seconds. You can only either enable or 
disable it.

The FS-4Pro includes all the items in the RECORD MENU explained 
below.

Step 1: Use the Up and Down Navigation Keys to move up and
down among the selections and the title. 

Step 2: For Retro Disk, Retro Cache, Loop Record, and Time
Lapse, use the Right Navigation key to display a sub
screen. The Sub Screen can be displayed even if a value
is unselected. 

• When you make a selection, it is marked with a “- “to the left of 
the selection.

• Once you select a particular mode in the Record menu, the FS-4 
remains in that mode until you select a different mode. When you 
exit to the Home screen, the newly selected mode is active. The 
top left hand of the Home screen displays the corresponding 
RECORD mode.
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Normal Record

This is the Standard record mode. All control is from the FS-4 front 
panel. When you press REC, the FS-4 begins standard recording. 
Pressing REC once puts the FS-4 into REC PAUSE mode. Pressing it 
a second time puts the FS-4 into RECORD mode. 

Retro Disk Record Mode (FS-4Pro Only)

Step 1: Press the Left Navigation key to display the Retro Disk
screen.

Step 2: Use the Left and Right navigation keys to sequence
through HH and MM.

Step 3: Use the Up and Down navigation keys to increment and
decrement values. This value is automatically limited to
the maximum remaining disk duration. 

Step 4: Adjust the minutes and hours value between 0 and 59.
Step 5: Select BACK to return to the RECORD Screen with the

current cursor row set to the RETRO DISK value.
The “HH:MM” row is for display only.

RETRO DISK records the video signal over itself in a continuous 
loop. RETRO DISK always keeps at least the amount of time that you 
select in a series of one-minute clips. 

NOTE: In order to function correctly, the FS-4 must always have at 
least one minute of disk space (under 60 minutes) or 9 minutes, 13 
seconds of disk space (when RETRO DISK value is set to greater 
than 60 minutes) remaining in addition to the set RETRO DISK value. 
For instance, it is not possible to set a RETRO DISK value of one 
minute if only one minute of disk space remains.

• Once the RETRO DISK time is set, An “L” appears next to the 
record symbol on the FS-4's display and also in the camcorder's 
viewfinder. 
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• You can use RETRO DISK in LOCAL, and SLAVE RECORD con-
trol modes. 

Retro Cache Record Mode

NOTE: You can only set RETRO CACHE in the FS-4Pro. On the FS-
4, it is either on (set by default to six seconds) or off.

Step 1: Use the Right Navigation key to display the Retro CACHE
screen.

Step 2: Use the Up and Down navigation keys to increment and
decrement values. This value is automatically limited to a
maximum of 10. Tens and ones digits are set separately.

Step 3: Press BACK to return to the RECORD Screen with the
current cursor row set to the RETRO CACHE value.

• The “:SS” row is for display only.
• RETRO CACHE RECORD can be used in LOCAL, SYNCRO 

RECORD and SLAVE RECORD control modes. 

Loop Record (FS-4Pro only)

LOOP RECORD is similar to RETRO DISK.

When you select LOOP RECORD, and press REC, video is recorded 
to available disk space. Clips are recorded to disk continuously as 
one-minute clips (up to 60 minutes - over 60 minutes, 2GB files). 
When the capacity of the disk is reached in LOOP RECORD, an addi-
tional one-minute (or 2GB) segment is created (The FS-4 always has 
at least 2GB of space in reserve on disk to carry out this function.). 
After this clip is complete, the oldest one-minute clip (or 2GB seg-
ment) is recorded over, followed by each sequential oldest clip. When 
you press STOP during a record session, REC stops and clips in the 
current LOOP RECORD session are saved to disk. They are also 
saved in a single folder.



34

Snap (FS-4Pro only)

When you select SNAP and press REC, a single frame is grabbed. 
SNAP can be used with LOCAL and SYNCRO RECORD control 
modes. If SNAP is the RECORD MODE when you turn off the power 
or power is interrupted, upon re-boot, the FS-4 will be in NORMAL 
REC mode.

Time Lapse (FS-4Pro only)

You can select an interval of up to twenty-four hours. The interval is 
the period of time between the FS-4 capture of a single frame of video 
(a value of 00:00:00:00 means no frames will be recorded). 

Step 1: Press the Right Navigation key from the Record Screen
to display the TIME LAPSE screen.

Step 2: Use the Left and Right navigation keys to sequence
through HH:MM:SS:FF. 

Step 3: Use the Up and Down navigation keys to increment and
decrement values. The value is automatically limited to 24
hours.

Step 4: Use BACK to return to the RECORD Screen with the
current cursor row set to TIME LAPSE value. 
The “HH:MM:SS:FF” row is for display only.

HDD Mode Screen
Value selections on this screen are mutually exclusive.
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DV Recorder

When you make this selection, the FS-4 functions as a DV Recorder, 
and expects I/O DV data from the camera FireWire connector.

DD Drive

When you make this selection, the FS-4 functions as a Volume, and 
mounts to a host computer using the computer FireWire connector. In 
this mode, you can also connect multiple FS-4 units together. 

Use External FS-4

This setting allows you to connect two FS-4 units together for long 
record times. One unit acts as the master, the second unit acts as a 
slave. When the master FS-4 is full, it begins recording on the slave 
FS-4 unit. 

NOTE: When you connect two FS-4 units together as described 
above and the FS-4 is in Record or Playback mode, when the master 
unit is being recorded to/played back from, the volume display shows 
a 1-XXX on the home screen. When the slave unit is being recorded 
to / played back from, the volume display shows 2-XXX on the home 
screen

Use this function as follows:

Step 1: Connect a camcorder to the desired master FS-4 using
the suppled FireWire cable.

Step 2: Power on FS-4 and navigate to the HDD Mode menu
screen and enable USE EXT FS-4 on the master unit.

Step 3: On the desired slave FS-4, power the unit on and navigate
to the HDD Mode menu screen and enable DD DRIVE on
the slave unit.

Step 4: Using a 6-pin to 6-pin FireWire cable, connect between
the two units’ Computer I/O connectors.

Step 5: Begin recording or playback using the master FS-4.

NOTE: It is important to take the master FS-4 out of USE EXT FS-4 
mode before attempting to connect to a computer. Use the standard 
DD DRIVE mode to do this.
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DV Format Screen
Use the Up and Down navigation keys to make a selection. When 
you select the options on this screen, the value is marked with a “- “. 

Possible values include:

• RAW DV
• AVI TYPE 1
• AVI TYPE 2
• CANOPUS AVI
• MATROX AVI
• QUICKTIME
• AVID OMF (FS-4Pro only)
• QUICKTIME 24P/25P
• AVI TYPE 2 24P/25P
• PINNACLE AVI (FS-4Pro only)

NOTE: When using AVID OMF or PINNACLE AVI formats, you must 
use the organize PINN or Organize OMF function in the Utilities 
Menu. Refer to the section, “Utilities Screen” on page 45.

The latest DTE supported applications and what file formats to use for 
each is listed on the FOCUS Enhancements website. Check regularly 
for updates.
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Setup Screen
Unlike other screens, selections on the Setup Screen are in mutually 
exclusive groups, or in some cases, making a selection takes you to a 
settings screen from which the only path back is the BACK key. 

The values for this screen include:

• DATE (Displayed) >
• TIME (Displayed) >
• VERSION (Displayed) >

• LCDLIGHT ON
• LCDLIGHT OFF
• LCDLIGHT AUTO;Group Default

• ALARM ON; Group Default
• ALARM OFF

• STOP FRAME; (1st frame of current clip) Group Default
• STOP GREY
• STOP NO VIDEO

• EXT CTL OFF; Group Default
• EXT CTL PLAY
• EXT CTL FRAME
• EXT CTL FILE

• TC EXT; Group Default
• TC REC RUN
• TC FREE RUN (FS-4Pro only) 
• TC REGEN (FS-4Pro only) 
• TC SET > 
• UB SET > FS-4Pro only

• TC DROP - NTSC only.
• TC NON-DROP; Group Default - - NTSC only.

• LCD CONTRAST
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DATE

When you make this selection, the SET DATE screen appears for set-
ting the date. 

Refer to the section, “Set the Time and Date” on page 14.

TIME

When you make this selection, the SET TIME screen appears for set-
ting the time. 

Refer to the section, “Set the Time and Date” on page 14.

VERSION

When you make this selection, the VERSION screen appears, and 
the screen displays the product ID in detailed form.
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• Use BACK to return to the SETUP Screen with the current cursor 
row set to VERSION value.

LCDLIGHT (GROUP)

Value selections on this screen consist of the following: LCDLIGHT 
ON, LCDLIGHT OFF, LCDLIGHT AUTO (Default)

This group allows you to enable or disable the FS-4's LCD's back-
light. Do this as follows:

Step 1: Make an LCD selection. The highlighted state is current
after you exit. 

Step 2: Press BACK to exit to the menu screen. 
• The LCDLIGHT ON setting keeps the backlight on 

permanently.
• The LCDLIGHT OFF setting keeps the backlight off 

permanently. 
• LCDLIGHT AUTO turns off the backlight after one 

minute.

In LCDLIGHT AUTO mode:

• Pressing any keypad key on the FS-4 turns the backlight back on 
(But will not carry out the function until pressed again with the 
back light on).

• Any INFORMATION screen turns the backlight on.

ALARM (GROUP)

Selections consist of the following: ALARM ON (Default) and ALARM 
OFF. Upon selection, the value is marked with a “- “. The alarm alerts 
you for conditions such as low battery charge, low disk space, or over 
heating of the FS-4, as well as the button feedback indicator.

STOP (GROUP)

Selections consist of the following: STOP FRAME (Default), STOP 
GREY, and STOP NO VIDEO.

• When you select STOP FRAME, the first frame of the clip is dis-
played.

• When you select STOP GREY, a grey frame is displayed
• When you select STOP NO VIDEO, video output is off.
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EXT (GROUP)

Selections consist of the following: EXT CTL OFF (default). EXT CTL 
PLAY, EXT CTL SNAP, and EXT CTL FILE.

• EXT CTL OFF allows you to connect a 3.5mm-to-DB9 cable to 
the GPI port and control the FS-4 using an RS232C cable from 
an external device. You can also use the FS-4 with the optional 
wired remote control unit.

The remaining three selections allow functions to occur from a simple 
contact closure. 

• EXT CTL PLAY allows control of pause and unpause during a 
record or playback session.

• EXT CTL FILE allows a new file to be created during a record 
session without losing any frames.

• EXT CTL SNAP allows a single frame of video to be recorded to 
a file. Each sequential use in this mode adds another frame to the 
same file until stopped. 

TIME CODE (GROUP)

Selections consist of the following: TC EXT (Group Default), TC 
RECRUN, TC FREE RUN (FS-4Pro ONLY), TC REGEN (FS-4Pro 
only),.

In TC EXT mode (FS-4Pro only), the incoming timecode source is 
recorded. If the TC is not running, and the FS-4 is recording, the 
same TC number will be in each recorded frame. Choose TC EXT 
mode to clear any stored number.

In TC REC RUN mode. the FS-4 does the following: 

• The last timecode number recorded + 1 is used as the timecode 
number for the first frame of the next recording.

• The number entered by a setting in the TC PRESET menu is 
used for the first frame of the next recording. 

• The last number used is stored in the memory, so this mode per-
sists across recording sessions. 

When you enable FREE INT mode, the FS-4 begins counting from 
the value stored. When you use the TC PRESET function, when the 
number is entered and the TC PRESET menu is exited, the FS-4 
begins counting.
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NOTE: When you set the camcorder Timecode mode to REC RUN, 
REGEN or EXT TC, the FS-4 will NOT record the timecode when 
recording to disk only. Use the FS-4 TC modes if you want any of 
these TC modes.   

TC SET (or TC / UB SET - FS-4PRO only)

This group allows you to enable or disable the FS-4's time code (TC). 

Step 1: Select TC SET. 

Step 2: Use the Left and Right navigation keys to sequence
through hours, minutes, seconds, and frame. Use the Up
and Down navigation keys to increment and decrement
values. 

Step 3: Press BACK to return to the SETUP Screen with the
current cursor row set to TC SET value. 

• The “HH/MM/SS/FF” row is for display only. 
• On the FS-4Pro only, you can set either a TC value or a User bit 

value. The selected mode (TC or UB) is the currently set mode. 
Move between modes by pressing the Left or Right navigation 
keys. The LCD updates accordingly. In UB mode, the HH/MM/SS/
FF disappears and so do the colons between the values.

DROP (GROUP) - NTSC versions only

Selections consist of the following: TC DROP and TC NON-DROP 
(Group Default). Upon selection, the value is marked with a “- “

LCD CONTRAST

Step 1: Press the Right navigation key to go to the submenu.
Step 2: Use the Up and Down navigation key to increment and

decrement the value. The LCD contrast changes
according the value. 
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Functions Screen
On the Home screen shown below, you can assign the Function keys, 
FA, FB, FC to toggle specific system settings.

These values are user-assignable in the Functions screen. Changing 
a setting with a Function key has a result identical to changing the 
setting in its corresponding menu. These have “last entry” priority. so 
changing a setting using a Function key, or changing it using the cor-
responding menu updates both screens. Functions are intended to be 
convenient Home screen shortcuts.

Selections on the Functions screen are in three groups, FA, FB, and 
FC. In each group selections are mutually exclusive, but there is no 
interaction between function groups.

Use the following table for the Function key menu. The default is 
listed first.

MENU Appears on LCD as…

FA SYNC SYNC (Toggles between SYNCRO and NORMAL record control) 
(default)

FA AV/C AV/C (Toggles between AV/C and NORMAL control)

FA TAPELESS TAPE (Toggles between TAPELESS TRIGGER and NORMAL 
control)

FA REEL1 R1 (Marks Clip to Reel 1) FS-4Pro only
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FA REEL2 R2 (Marks Clip to Reel 2) FS-4Pro only

FA REEL3 R3 (Marks Clip to Reel 3) FS-4Pro only

FA REEL4 R4 (Marks Clip to Reel 4) FS-4Pro only

FA REEL5 R5 (Marks Clip to Reel 5) FS-4Pro only

FA REEL6 R6 (Marks Clip to Reel 6) FS-4Pro only

FA REEL7 R7 (Marks Clip to Reel 7) FS-4Pro only

FA REEL8 R8 (Marks Clip to Reel 8) FS-4Pro only

FA REEL9 R9 (Marks Clip to Reel 9) FS-4Pro only

FA REEL10 R10 (Marks Clip to Reel 10) FS-4Pro only

FA LCDON LCD1 (LCD On/Off Toggle)

FA LCDAU LCDA (LCD Auto On/On Toggle)

FA BLANK No Function.

FB DISP DISP (Toggles the different TC display modes) (Default)

FB ALARM Turns the FS-4 alarm on or off.

FB FILE FILE (Toggles between normal and display of the file name)

FB REEL1 R1 (Marks Clip to Reel 1) FS-4Pro only

FB REEL2 R2 (Marks Clip to Reel 2) FS-4Pro only

FB REEL3 R3 (Marks Clip to Reel 3) FS-4Pro only

FB REEL4 R4 (Marks Clip to Reel 4) FS-4Pro only

FB REEL5 R5 (Marks Clip to Reel 5) FS-4Pro only

FB REEL6 R6 (Marks Clip to Reel 6) FS-4Pro only

FB REEL7 R7 (Marks Clip to Reel 7) FS-4Pro only

FB REEL8 R8 (Marks Clip to Reel 8) FS-4Pro only

FB REEL9 R9 (Marks Clip to Reel 9) FS-4Pro only

FB REEL10 R10 (Marks Clip to Reel 10) FS-4Pro only

FB BLANK No Function.

FC LOCK Locks the keypad (Default) - toggles between LOCK and UNLC 
<Unlock>

FC DV/HDD Toggles FS-4 between DV and HDD Modes

FC DD R1 (Marks Clip to Reel 1) FS-4Pro only
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Function Selection Operation from Home Screen:

Press the function to sequence through all possible selections of the 
assigned group's values. For example if you selected FA REELS, 
pressing the Function A key would cycle and display R1-R2-R3-R4-
R5-R6-R7-R8-R9, and so on.

The following operations are the same for either A, B, and C Function 
operation:

BLANK

For this selection, nothing is displayed above the function key on the 
HOME Screen. Pressing the corresponding Function key has no 
effect.

The illustration below shows an example of the Home Screen with 
functions assigned:

FC REEL2 R2 (Marks Clip to Reel 2) FS-4Pro only

FC REEL3 R3 (Marks Clip to Reel 3) FS-4Pro only

FC REEL4 R4 (Marks Clip to Reel 4) FS-4Pro only

FC REEL5 R5 (Marks Clip to Reel 5) FS-4Pro only

FC REEL6 R6 (Marks Clip to Reel 6) FS-4Pro only

FC REEL7 R7 (Marks Clip to Reel 7) FS-4Pro only

FC REEL8 R8 (Marks Clip to Reel 8) FS-4Pro only

FC REEL9 R9 (Marks Clip to Reel 9) FS-4Pro only

FC REEL10 R10 (Marks Clip to Reel 10) FS-4Pro only

FC BLANK No Function.
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Utilities Screen
This menu allows you to access the FS-4 UTILITIES modes as fol-
lows: 

Step 1: Select the Menu Item using the Up and Down navigation
keys. 

Step 2: Press Select to open the sub menu (where applicable).

Values include:

• ORGANIZE REEL (FS-4Pro only)
• ORGANIZE OMF (FS-4Pro only)
• ORGANIZE PINNACLE (FS-4Pro only)
• DELETE CLIP >
• FORMAT >
• REPAIR DISK >
• REPAIR CLIP >
• FILE NAME >
• UPGRADE >
• SYSTEM RESET >
• STATUS >

ORGANIZE REEL (FS-4Pro Only)

This selection places all file identified as a REEL clip during recording 
or playback into the appropriate reel folder. You can import this folder 
directly into most DV NLE bins.

ORGANIZE OMF (FS-4Pro Only)

When files are recorded in the AVID OMF file format, this selection 
allows you to take all the OMF and AIF audio files at the end of a 
recording session and place them into a folder on the disk drive 
named OMFI MediaFiles. When the disk is connected to a computer, 
this folder is recognized by Avid Xpress DV's Media Tool enabling 
direct import of files into the Avid timeline. Refer to the section, “Using 
Avid OMF Clips (FS-4Pro only)” on page 23 for more information.
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ORGANIZE PINNACLE (FS-4Pro Only)

This selection organizes clips for use with Pinnacle Liquid series NLE 
systems. Products such as the Pinnacle AVI file format were created 
for use with products such as Pinnacle Liquid Edition. The Pinnacle 
AVI file format creates three files simultaneously during a recording; 
an AVI video file and two separate WAV audio files labeled as left and 
right. An additional Edition.ale file for each recording session is also 
created which contains timecode data. This file must be kept with the 
media. 

Once clips have been imported into Liquid Edition, an Index file is cre-
ated on the disk drive for each clip. Do not delete this file since it is 
required to continue work in the particular project. 

DELETE CLIP

This selection deletes a selected clip.

Step 1: From the Utilities screen, use the Down navigation key to
move the cursor to DELETE CLIP. The row appears as
inversed text.

Step 2: Press Select. The following screen appears.

Step 3: Use the Left and Right navigation keys to sequence
through clip digits. Use the Up and Down navigation keys
to increment and decrement digit values.

Step 4: When you select YES, the following occurs:
• The selected clip is deleted.
• The cursor is set to the ones digit. 

Step 5: Press BACK to return to the Utility Screen.
Once you delete a clip, the FS-4 displays a re-organized clip number 
sequence. For instance, if there are three clips on the disk (1-001, 1-
002, 1-003) and you delete clip 1-002, after deletion is complete, clip 
1-003 becomes clip 1-002. However, base file names are not 
affected.
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FORMAT DISK

FOCUS Enhancements recommends that the FS-4 is formatted after 
each recording to prevent lost frames due to fragmentation.

NOTE: FORMATTING WILL ERASE ALL DATA ON DISK! Back up or 
transfer any files or clips on the FS-4 before selecting a format. 

This selection formats the disk as follows:

Step 1: From the Utilities screen, use the Down navigation key to
move the cursor to Format Disk. The row appears as
inversed text.

Step 2: Press Select. The following screen appears.

Step 3: Select YES to begin formatting and a status screen
appears.
Upon complete or error, the screen displays a completion 
message. The message will be either “Aborted,” or 
“Complete.” 

Step 4: Select BACK to return to the Setup Screen with the
current cursor row set to FORMAT DISK.

REPAIR DISK

This selection repairs the disk as follows:

Step 1: From the Utilities screen, use the Down navigation key to
move the cursor to Repair Disk. The row appears as
inversed text.
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Step 2: Press Select. The following screen appears.

Step 3: Select YES and the FS-4 begins repairing the disk and
displays a status screen.
Upon complete or error, the screen displays either 
“Aborted” or “Complete.”

Step 4: Press BACK to return to the Utility Screen with the current
cursor row set to REPAIR DISK. 

REPAIR CLIP

This selection repairs a clip that may have errors. Repair clip works 
as follows:

Step 1: From the Utilities screen, use the Down navigation key to
move the cursor to Repair Clip. The row appears as
inversed text.

Step 2: Press Select. The following screen appears.

Step 3: Use the Left and Right navigation keys to sequence
through the clip digits. Use the Up and Down navigation
keys to increment and decrement the digit values.

Step 4: Select YES. The FS-4 begins repairing and displays a
status screen.
Upon complete or error, the screen displays either 
“Aborted” or “Complete.”

Step 5: Press BACK to return to the Utility screen with current
cursor row set to REPAIR CLIP.
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FILE NAME

This selection allows you to display (not change) a file name:

Step 1: From the Utilities screen, use the Down navigation key to
move the cursor to FILE NAME. The row appears as
inversed text.

Step 2: Press Select. The following screen appears.

Step 3: Use the Left and Right navigation keys to sequence
through clip digits. User the Up and Down navigation
keys to increment and decrement digit values.
The base file name is dynamically displayed as a function 
of the clip number 
When a clip has multiple files, the first Base file name is 
displayed

Step 4: Press BACK to return to the Utility screen with the current
cursor row set to FILE NAME.

UPGRADE

To upgrade system software, use the following steps:

Step 1: Set the FS-4 to HDD Mode and connect it to a computer.
Step 2: On your computer, rename the XXX.bin file as follows:

FS4.bin. 
Step 3: Copy the FS4.bin file to the FS-4 while it is in HDD mode. 
Step 4: Exit the FS-4 from HDD mode and navigate to the Utilities

screen.
Step 5: From the Utilities screen, use the Down navigation key to

move the cursor to Upgrade. The row appears as
inversed text.

NOTE: Check the FOCUS Enhancements website for available 
updates.
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Step 6: Press Select. The following screen appears.

Step 7: Press Select to begin the OS upgrade. The upgrade
begins and a status screen appears.
When completed the screen displays either “Aborted” or 
“Complete”

Step 8: Press BACK to return to the Setup screen with the cursor
row set to UPGRADE.

SYSTEM RESET

The System Reset feature allows you to restore the factory default 
settings for your FS-4 unit. This feature is useful for diagnosing prob-
lems with your unit. 

NOTE: A System Reset cannot be reversed!

STATUS

The FS-4 Status screen provides details of the systems power state 
as well as internal temperature. This screen may assist FOCUS 
Enhancements Technical Support in determining power and thermal 
problems with your unit.

REELS SCREEN (FS-4Pro only)

When a disk is formatted, the FS-4 creates 10 folders numbered 0-9 
on the disk. You can name these folders anything (up to 10 charac-
ters) when the FS-4 is mounted to a computer in DD mode. During 
recording or playback of a particular clip, you can place clips into fold-
ers or play from up to 9 different reels. 

From the Reels Screen, chose the Reels as follows:

Step 1: From the Utilities screen, use the Down navigation key to
move the cursor to Reels. The row appears as inversed
text.

Step 2: Press Select. The following screen appears.
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Values include:

• R1 “Reel Name”; Default Value
• R2 through R9 “Reel Name”

Mark a clip to any reel by pressing a key during a recording (in addi-
tion to the function keys). 

• Upon select, value is marked with a “- “
• Actual reel names are limited to 10 characters

When you use the optional wired remote control, use the keypad 
numbered 0-9 to directly mark clips. Any additional key presses dur-
ing a recording or playback, changes the selected folder. Once a ses-
sion is finished, select ORGANIZE REEL in the utilities folder where 
the clips are placed in the reel in sequential order. 

PLAY SCREEN

Step 1: From the Utilities screen, use the Down navigation key to
move the cursor to PLAY. The row appears as inversed
text.

Step 2: Press Select. The following screen appears.
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Play Clip

In this mode, the FS-4 plays the selected clip from start to finish when 
you press the PLAY key. At the end of the particular clip, the FS-4 
pauses.

Play All 

In this mode, the FS-4 plays the entire contents of the disk (all clips) 
in order from start to finish. At the end of the last clip, the FS-4 
pauses. 

Loop Clip

In this mode, the FS-4 plays the selected clip from start to finish. 
Immediately after completing the clip, the FS-4 begins playing the clip 
again without a pause. It stays in this state until stopped.

Loop All 

In this mode, the FS-4 plays the entire contents of the disk (all clips), 
in order, from start to finish. At the end of the last clip, the FS-4 begins 
to play from the beginning of the first clip again without a pause. It 
stays in this state until stopped.

Play From Screen (FS-4Pro Only)

This screen allows you to select from where clips will playback. There 
are two choices: 

• TRACKLIST - clips are played back in the order in which 
they were recorded (based on the order of the file name). 

• REEL - clips in a selected folder are played back. You 
can choose between any folders on the disk. Each 
appears with its given folder name (if applicable). 
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Control Screen
Use the Left or Right navigation keys to cycle to the following screen.

Values include:

• LOCAL 
• AV/C 
• SYNCRO SLAVE
• TAPELESS TRIGGER

LOCAL

Local control mode ignores record triggers from the camcorder and is 
controlled exclusively from the FS-4 front panel or the optional wired 
remote control unit.

AV/C

Use AV/C in PLAYBACK mode and other situations where the FS-4 is 
controlled by an external FireWire device such as a DV NLE system 
that is not supported by Direct To Edit Technology. In these cases, the 
FS-4 can be used to capture footage to the NLE with the same 
behavior as a camcorder.

NOTE: AV/C is NOT for use in FS-4 RECORD MODES.

Syncro Slaved

In SYNCRO SLAVED mode, a camcorder and the FS-4 share the 
same REC trigger and the FS-4 is slaved to the camcorder. To use 
this mode, refer to the section, “Syncro Slave Recording” on page 18.

Tapeless Trigger

The tapeless trigger mode allows the FS-4 to be controlled from a 
camcorder if it features an external DV control setting separate from 
the tape transport. Typical camcorders like this include the Sony 
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DSR-390, DSR-370, DSR-570, Canon XL1s and XL2 and the Pana-
sonic DVX-100/-100A. 

FS-4 LCD Display Modes
The table below shows the different symbols and states displayed on 
the top line of the LCD when used with different FS-4 control, record, 
play and stop modes:

PLAY/REC MODE FS-4 LCD 
Stop STOP
Pause ll PLAY
Play > PLAY
Rec (Pause) ll REC
Normal Rec (Rec) REC
Retro Disk (Stop) L STOP
Retro Disk (Standby) L REC
Retro Cache (Stop) C STOP
Retro Cache (Standby) C REC
Loop Record (Stop) O STOP
Loop Record (Standby) O REC
Loop Record (Rec) O REC
Snap (Stop) STOP
Snap (Standby) ll SNAP
Snap (Rec) ll SNAP
Time Lapse (Stop) STOP
Time Lapse (Pause) ll T REC
Time Lapse (Rec) T REC

CONTROLTYPE FS-4 LCD
AV/C* (Stop) A STOP
AV/C* (Rec Pause) ll A <REC TYPE> REC
AV/C* (Rec) A <REC TYPE> REC
AV/C* (Play Pause) ll A PLAY
AV/C* (Play) A ALL
Syncro Slave (Pause) ll Y <REC TYPE>REC
Syncro Slave (Rec) Y <REC TYPE>REC
Tapeless (Pause) ll E <REC TYPE>REC
Tapeless (Rec) E <REC TYPE>REC

* AV/C is only for use when the FS-4 is connected to a computer sys-
tem.
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Technical Specifications
NOTE: Specification are subject to change.

Physical Description
• Dimensions: 1.59" x 5.6" x 3.74" (40mm x 142mm x 

95mm) (with normal 90 minute Battery) 
• Weight: 1 lb. (.45 kg)

Input/Outputs 
• DV Video I/O - 25Mb/s (1x 6-pin IEEE-1394) 
• FireWire Computer I/F - up to 400Mb/s (1 x 6-pin IEEE-

1394) 
• GPI & RS-232C Control (1 x 3.5mm mini jack)

Power 
• 15V DC, 7.5W 
• Mini-jack power connector 
• Custom Removable Li-ion Rechargeable Battery Pack 

(90 minutes estimated run-time)

Audio/Video/Timecode Specification 
• 25Mb/s, 8-bit 4:1:1 (NTSC-DV) or 4:2:0 (PAL-DV) video 

(model dependent) 
• DV Embedded Timecode (Drop or Non-Drop) 
• Embedded 2-ch (16-bit, 48kHz) or 4-ch (12-bit, 32kHz) 

Audio

DTE File Formats 
• RawDV, AVI Type 1, AVI Type 2, Matrox AVI, Canopus 

AVI, QuickTime, AVI Type 2 24p, QuickTime 24p 
• FS-4Pro Only: Pinnacle AVI and AVID DV OMF 

Disk Information 
• Internal Disk Type: 40GB (or 80GB - FS-4Pro only), 

5400RPM, 8 MB cache 
• Disk Format: FAT32 
• FS-4 compatible with Windows 98SE, ME, 2000, XP and 

Mac OS9/10.
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Log Files
With each recording of a particular clip on a disk, the FS-4 creates a 
text log file to identify information about the recorded clip and the 
recording session. Information includes:

• Clip name
• Clip in/out source TC values
• Clip duration
• Clip type (record file type). 

The log file also identifies when the shock cache becomes low and 
when disk or other errors occur during a recording.

Error Messages
Error messages may appear on the FS-4 LCD display from time to 
time. The purpose of these messages is to alert you to action that 
may effect your FS-4 operation. Below is a list of error messages and 
actions you can take:

Warranty
• 1 year FS-4
• 2 year FS-4Pro
• 90 Days Accessories including the battery.

Error Message Description Action

LOW BATTERY! Battery power is low. Connect AC Power or replace the bat-
tery pack.

OVER TEMP! The unit is getting too hot for 
normal operation.

Make sure the vent and fan intake 
holes are clear.

NO SPACE LEFT! The Disk Drive is Full. Transfer files off the drive and format it 
before attempting to do more record-
ing.

DISK ERROR XXX Lost Disk Communication. Contact FOCUS Enhancements Tech-
nical Support.

NO DISK 
DETECTED

Lost Disk Communication. Contact FOCUS Enhancements Tech-
nical Support.
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Temperature
• Operating: 0-40º C (32 - 104º F)
• Operating humidity: 30% to 90% RH
• Storage temperatures:  -20 to 60° C (-4° to 140°F)
• Storage humidity:  85% RH or less

Compatible Camcorders 
For a list of tested camcorders, refer to www.focusinfo.com.

Optional Accessories
For a complete list of optional accessories for the FS-4, visit the 
FOCUS Enhancements website at www.focusinfo.com.


